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Getting Started

Clck on the Hew Safety System configuration ta advance to th
Device Selection page where you Can create 3 new configuration from an
offine device in the Catalogue list.

Opening a Safety System configuration alows you to load a previously
saved configuration from the PC to change it or upload it to the scanner
via the Programming item

Cick on Modify Safety System configuration to Discover your deviee on the
Lan and change its configuration,

P Contextualelp
Contextual Help s provided for each configuration step, Just cick on the
help icon n the tookar at the top. A correspanding page of collspsed Help
descriptions opens. You can view the descrptions by cidng on the
parameter name with the @ icon.

For information about using Dl.Sentinel GUI, refer to the DLSentinel User's.
manual. You can open it from the Help menu or from the Windows Start
menu under Al Programs>Datalogic >DLSentinel>x.x.x{sw version)
>Documentation.

User's manual

[ nctruction maniai

For information about using the Laser Sentinel scanner, refer to the Laser
Sentinel Instruction manual. You can open it from the Help menu or
from the Windows Start menu Lnder Datalogic>DLSentinel>x.x, k{5
version) >Documentation,

Laser Sentinel User Interface Client Application

Task Selection

New Safety System configuration
Create a new Safety System configuration

Open a Safety System configuration from PC
Edit a Safety System configuration saved on PC

Modify Safety System configuration from a scanner on the network

Edit a Safety System configuration from a scanner on the network

Monitor Safety System
Monitor a scanner on the network

Read a Safety System report from a scanner on the network
Show a Safety System report from a scanner on the network

Read a Safety System report from PC
Show a Safety System report from PC
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GRAPHIC USER INTERFACE END USER
LICENSE AGREEMENT

Whenever YOU download or use the GRAPHIC USER INTERFACE (“GUI”) this End User
License Agreement (“License”) applies to YOU, as final end user, and Licensor. Licensor
means Datalogic IP Tech S.r.l. having its registered office at Via San Vitalino 13, 40012
Calderara di Reno, VAT number 03159561202, Italy. This License governs your use of
the GUI and related user documentation (the “GUI”). Any Open Source used in a con-
junction with the Software is subject to the Open Source licenses available at the fol-
lowing website: http://www.datalogic.com/oss.

By downloading and/or using the GUI, YOU are agreeing to the terms of this License. If
YOU don’t agree with any of these terms, YOU cannot download or use the GUL.

a. License. Subject to the restrictions this License, Licensor grants YOU a non-exclusive,
non-transferable, non-sublicensable, limited license to download, install and use in
object code form a single copy of the GUI only on one single computer that YOU own or
control, which system requirements shall comply with requirements provided by Licen-
sor, and solely in conjunction with Datalogic Laser Sentinel, defined below, for which it is
intended for use.

Title to the licensed GUI shall be and remain with Licensor or the third party from whom
Licensor has obtained a license right. This License does not grant to YOU any intellectual
property rights on GUI.

b. License Restrictions. YOU may not distribute or make the GUI available over a net-
work where it could be used by multiple devices at the same time, unless otherwise
permitted in writing by Licensor.

YOU may not rent, lease, lend, sell, redistribute or sublicense the GUI. YOU may not
copy (except as expressly permitted by this), decompile, reverse engineer, disassemble,
attempt to derive the source code of, modify or adapt the GUI, in whole or in part,
merge the GUI into another program, use the GUI in any manner inconsistent with this
License or create derivative works of the GUI, any updates, or any part thereof (except
as and only to the extent any foregoing restriction is prohibited by applicable law or to
the extent as may be permitted by the licensing terms governing use of this License).
YOU may print copies of any user documentation provided in online or electronic form
for your personal use. If YOU breach these restrictions, YOU may be subject to prosecu-
tion and damages and this License would be immediately terminated.

c. Changes of License. Licensor reserves the right to change all or a part of the License at
any time. If Licensor does that, Licensor will post the changed terms at the following
website: http://www.datalogic.com. Click on Support > Search by product and enter the
Laser Sentinel family name, then select your product from the dropdown list. Click on the
Software & Utilities link to download the License.

IF YOU CONTINUE TO USE THE GUI AFTER LICENSOR POST CHANGED TERMS, THEN
YOUR USAGE WILL CONSTITUTE YOUR EXPLICIT ACCEPTANCE OF THE CHANGED
TERMS.
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Licensor is constantly evolving its products. This means Licensor may change or discon-
tinue GUI (and/or our website and any of our other services) without notice or any lia-
bility to YOU.

d. Termination. The license is effective until terminated by YOU or Licensor. Your rights
under this license will terminate automatically without notice from the Licensor if (i)
YOU fail to comply with any term(s) of this license; (ii) YOU delete the GUI; and, to the
extent applicable, (iii) YOU use the GUI in connection with a paid service or paid prod-
uct, the end of the time period specified at time of purchase. Upon termination of the
license, YOU shall cease all use of the GUI, and destroy all copies, full or partial, of the
GUL.

e. Datalogic Laser Sentinel. The GUI may enable access to Datalogic laser product, Data-
logic Laser Sentinel for configuration purposes.

f. Intellectual Property Rights. Except for the rights explicitly granted in this License,
Licensor retains and/or control all right, title and interest (including all copyright, pat-
ents, trademarks, service marks, trade secrets, or other intellectual property rights) in
the GUI, including the copies of the GUI on your computer. YOU acknowledge that the
GUI constitutes valuable trade secrets of Licensor or its third-party licensors and that
the GUI is protected by intellectual property laws and treaties. YOU shall not remove,
modify, or take any other action that would obscure any copyright, trademark, patent
marking, or other intellectual property notices contained in or on the GUI. Certain of
the product and service names used in this License and in the GUI may constitute trade-
marks of Licensor or third parties. YOU are not authorized to use any such trademarks,
except as it is permitted by applicable laws and agreements. All trademarks are the
property of their respective owners.

g. NO WARRANTY. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE GUI IS
AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFOR-
MANCE, ACCURACY AND EFFORT IS WITH YOU. TO THE MAXIMUM EXTENT PERMITTED
BY APPLICABLE LAW, THE GUI IS PROVIDED "AS IS" AND “AS AVAILABLE”, WITH ALL
FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND APPLICATION PROVIDER HEREBY
DISCLAIMS ALL WARRANTIES AND CONDITIONS WITH RESPECT TO THE GUI AND ANY
SERVICES, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, OF SATISFAC-
TORY QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, OF QUIET
ENJOYMENT. LICENSOR DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR
ENJOYMENT OF THE GUI, THAT THE FUNCTIONS CONTAINED IN, THE GUI WILL MEET
YOUR REQUIREMENTS, THAT THE OPERATION OF THE GUI OR SERVICES WILL BE UNIN-
TERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE GUI WILL BE CORRECTED. NO
ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY LICENSOR OR ITS AUTHORIZED
REPRESENTATIVE SHALL CREATE A WARRANTY. SHOULD THE GUI PROVE DEFECTIVE,
YOU ASSUME THE ENTIRE COST OF ALL NECESSARY REPAIR OR CORRECTION. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITA-
TIONS ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE EXCLUSION
AND LIMITATIONS MAY NOT APPLY TO YOU.

h. Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL
LICENSOR BE LIABLE FOR PERSONAL INJURY, OR ANY DIRECT, INCIDENTAL, SPECIAL,
INDIRECT OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIM-
ITATION, DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR
ANY OTHER COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO
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YOUR USE OR INABILITY TO USE THE GUI, HOWEVER CAUSED, REGARDLESS OF THE THE-
ORY OF LIABILITY (CONTRACT, TORT OR OTHERWISE) AND EVEN IF APPLICATION PRO-
VIDER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME
JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY,
OR OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT
APPLY TO YOU.

i. Export. YOU may not use or otherwise export or re-export the GUI except as autho-
rized by United States law and the laws of the jurisdiction in which the GUI was
obtained. In particular, but without limitation, the GUI may not be exported or re-
exported (a) into any U.S. embargoed countries or (b) to anyone on the U.S. Treasury
Department's list of Specially Designated Nationals or the U.S. Department of Com-
merce Denied Person’s List or Entity List or to anyone towards whom any EU Council
Regulation impose restrictive and sanctioned measures. By using the GUI, you represent
and warrant that you are not located in any such country or on any such list. YOU also
agree that YOU will not use these products for any purposes prohibited by United States
and EU law, including, without limitation, the development, design, manufacture or pro-
duction of nuclear, missiles, or chemical or biological weapons.

l. Open source. Portions of GUI include or operate with Open Source software (“Open
Source Software”).

Open Source Software is software covered by a publicly available license governed
solely under Copyright law, whereas the complete terms and obligations of such license
attach to a licensee solely through the act of copying, using and/or distributing the
licensed software, such obligations often include one or more of attribution obligations,
distribution obligations, copy left obligations, and intellectual property encumbrances.
The use of any Open Source Software is subject to the terms and conditions of this
License as well as the terms and conditions of the corresponding license of each Open
Source Software package. If there is a conflict between the terms and conditions of this
License and the terms and conditions of the Open Source Software license, the applica-
ble Open Source Software license will take precedence. Licensor is required to repro-
duce the software licenses, acknowledgments and copyright notices as provided by the
authors and owners, thus, all such information is provided in its native language form,
without modification or translation. Please reference and review the above mentioned
information to identify which Open Source Software packages have source code pro-
vided or available.

m. Confidentiality. YOU acknowledge that GUI content and associated documentation,
including the specific design and structure of individual programs, constitute trade
secrets and/or copyrighted material of Licensor (and/or its third party’s licensors). YOU
shall keep the GUI and any related material in strict confidence with all applicable laws.
YOU shall not disclose, provide, or otherwise make available the Proprietary Informa-
tion of Licensor or its third-party licensors to any person and YOU will use such informa-
tion only for internal business purposes. YOU shall take steps to protect this information
no less securely than if it were your own intellectual property. The provisions of this Pro-
prietary Information Section shall survive and continue for five (5) years after the termi-
nation of this License.

n. Applicable Law/Jurisdiction.

n.1 Both parties agree to the application of the laws of the country in which YOU
obtained the license to govern, interpret, and enforce all of Your and Licensor’s respec-
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tive rights, duties, and obligations arising from, or relating in any manner to, the subject
matter of this License, without regard to conflict of law principles. The United Nations
Convention on Contracts for the International Sale of Goods does not apply.

n. 2 All rights, duties, and obligations are subject to the courts of the country in which
YOU obtained the license.

For licenses granted to You who operate in the countries specified below, the following
terms apply:

For Americas.

This License and the rights of the parties hereunder shall be governed by and construed
in accordance with the laws of the State of Oregon U.S.A, without regard to the rules
governing conflicts of law. The state or federal courts of the State of Oregon located in
either Multnomah or Lane counties shall have exclusive jurisdiction over all matters
regarding this License, except that Licensor shall have the right, at its absolute discre-
tion, to initiate proceedings in the courts of any other state, country, or territory in
which YOU reside, or in which any of your assets are located. In the event an action is
brought to enforce the terms and conditions of this License, the prevailing party shall be
entitled to reasonable attorneys’ fees, both at trial and on appeal.

Use, duplication, or disclosure of the Software by the U.S. Government is subject to the
restrictions for computer software developed at private expense as set forth in the U.S.
Federal Acquisition Regulations at FAR 52.227-14(g), or 52.227-19 or in the Rights in
Technical Data and Computer Software clause at DFARS 252.227-7013(c)(1)(ii), which-
ever is applicable.

For Europe, Middle East and Africa

This License and the rights of the parties hereunder shall be governed by and construed
in accordance with the laws of Italy, without regard to the rules governing conflicts of
law. Italian Court of Bologna shall have exclusive jurisdiction over all matters regarding
this License, except that Licensor shall have the right, at its absolute discretion, to initi-
ate proceedings in the courts of any other state, country, or territory in which YOU
reside, or in which any of Your assets are located. In the event an action is brought to
enforce the terms and conditions of this License, the prevailing party shall be entitled to
reasonable attorneys’ fees, both at trial and on appeal.

For Asia- Pacific Countries

The validity, interpretation and construction of the License shall be governed by and
construed in accordance with Laws of the Republic of Singapore. Parties expressly dis-
claim the application of the United Nations Convention for International Sale of Goods.

Any dispute arising out of or in connection with this contract, including any question
regarding its existence, validity or termination, shall be referred to and finally resolved
by arbitration administered by the Singapore International Arbitration Centre (“SIAC”)
in accordance with the Arbitration Rules of the Singapore International Arbitration Cen-
tre ("SIAC Rules") for the time being in force, which rules are deemed to be incorpo-
rated by reference in this clause. The seat of the arbitration shall be Singapore.

The number of arbitrators will be three, with each side to the dispute being entitled to
appoint one arbitrator. The two arbitrators appointed by the parties will appoint a third
arbitrator who will act as chairman of the proceedings. Vacancies in the post of chair-
man will be filled by the president of the SIAC. Other vacancies will be filled by the
respective nominating party. Proceedings will continue from the stage they were at
when the vacancy occurred. If one of the parties refuses or otherwise fails to appoint an
arbitrator within 30 days of the date the other party appoints its, the first appointed
arbitrator will be the sole arbitrator, provided that the arbitrator was validly and prop-
erly appointed. All proceedings will be conducted, including all documents presented in
such proceedings, in the English language. The English language version of these terms
and conditions prevails over any other language version.
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n3._Attorneys’ Fees. In the event an action is brought to enforce the terms and condi-
tions of this License, the prevailing party shall be entitled to reasonable attorneys' fees,
both at trial and on appeal. Proposals, oral or written, and all other communications
between the parties relating to the subject matter of this License. Any terms and condi-
tions of any purchase order or other instrument issued by YOU in connection with this
License which are in addition to, inconsistent with or different from the terms and con-
ditions of this License shall be of no force or effect. This License may be modified only
by a written instrument duly executed by the parties. Any waiver by either party of any
condition, part, term, or provision of this License shall not be construed as a waiver of
any other condition, part, term or provision or a waiver of any future event or circum-
stance. If any provision of this License is held unenforceable, or invalid, the remainder
of the License shall continue in full force and effect.

Effective. November 10, 2017.

DAU!&EDSIDG USER'S MANUAL vii



TABLE OF CONTENTS

PREFACE .......coiiiiiiemmnanimisisssnnsssnssnasssnsns s s nnss samamnn s e e s nmnan e n e e amn R a R e e Enaannmnnnn IX
About this ManUal ........ccccrussssemssssmsssssmmmssssmisssssmsssessssssssassasass sssnsssssasssssnssssns snssansssasmnss ix
MaNUAL CONVENTIONS ....vuvvrieeerereeesescrneessesesessssssssessessssssessssessssssssessssessesssssessssssnssessessessessessenssssensans iX
Technical SUPPOIt ....eeiiissersssmsrsssnsssssmnsssn s s sssms srs s s s sssmseasmsnnsssns snaannssnsmnen s sannnssnmnessans snnsnnes X
SUPPOrt Through the WEDSIEE ... ssssess st ssssses s ssssssssssssssssesssssnsnns X
CHAPTER 1. DLSENTINEL GRAPHIC USER INTERFACE........ccccccurmrmssssammmmmrnmmsssssnsnnnnns 1
Program Description ...cccecsseceeseessmmmmmmmmmsssssssssnnssnmssnnnssnmmssssasssssnsssnnsnnnnsnnnessnnnnssssnsssnnnsnnnnnns 1
Before using DLSentinel ....cccuccermsssmmssanmsssssmssssnnsssnmssssansssssnsssssansssannnsssasssnsanssssnnnsssnnnnsnns 2
Installing DLSentinel .......ccccussemmmmsnsmmssnmssssnnssssanssssnnssssnnssssnnnssssansssannnsssnns snssnnssssnnsssnnnnsnses 2
MiniMUM SyStemM REQUIFEMENTS ......cveeeeceeireereseeesseseseseessesesesssssssssssssssesesssssssssssssssssssssssessessssessees 2

Program INStAllation .......c.ec e seesssesssssssssssssssesss s sessessessesssssssssssessssssssssssssssessssesssens 2
DLSentinel user iNterface .....csussssssssssssmnssassmsasssnnsmsnsssnnsssansssmnssnnsssnnssnssnsnnssnnsssnnsssnnnsnns 4
T 4T T TSP 5

TOOLDAM BULLONS ..cvuvevreeeesceeieetseees et ees st s s s s 6

TASK SELECHION .vuvvreereeeeseeeseieeeeees st es et es et bt bbb b s 6

Laser Sentinel configuration checklist .........cccusscmmmimmnmmsnmnsssnnmm s e e 7
CHAPTER 2. LASER SENTINEL CONFIGURATION.........cccurmsusmmmmmssmnmsmsssansanssssnsnsnsssnnsnss 8
Establishing Ethernet Communications with the Scanner .... 8
DLSentinel Device Discovery through @ NEtWOTK ........c.cccreeninensnieneene e sesseees 9
Point-to-Point Configuration PC Static IP Addressing Aignment .........cc..eveneereeeneernemeesneesesneens 10

Modify Safety System Configuration from a Scanner on the Network .........cccccmisimrricannans 14
CoONfIGUrAtION SEHINGS ..ouvvvureeieererresreseesse s ssss st s s 16

OULPUL CONFIGUIALION w.tvvrieereeceteeiee ittt s 17

Z0NE St CONFIGUrALION uuvvuieeieereeieseissiise s st s bbbt s 19

[NPUL CONFIGUIATION vvvvreeiee ettt et s s s 20
Detection CONFIGQUIATION .......cvreereeieeieseeseesssessse sttt ss s ss sttt sess st sttt anss st essnes 22
Profinet/Profisafe CONfIQUIration .........oueecueeeueeeeene i sesssesss s s ssessses s s sesssssssssssnees 23

Z0NES CONFIGUIALION «.vuvvurirriscieeieet et s s s s 26

ACting 0N Drawn ODBJECES ....cuueieieureeceeeireesieessei ettt bbbttt bbb 32

Selecting and Visualizing Areas on the Graph ... 39

New Configuration Selection ........ccceciccseisssmmmssssmsssmmsssmsssssnssssnmssssmssnssss s sssms s ssmssssmasnass 40
Save the Configuration .........ccccicomicisimissmnsss s s s e s s s s nme e nnans 41
Open a Previously Saved Safety System Configuration From PC .........cccuiemmrismrmnsannnsnens 42
CHAPTER 3. PROGRAMMING AND MONITORING FUNCTIONS............ccoecmmmmrmmmsssnnnnnns 45
Programming ..cucucsessssssmsissmmsssmmsssmmssm s s nss s s s s s nnnn s s nan s nnn e mnnnnnn 45
Monitoring And Controller SIMUlator .......ccrueemisemmssmmemsmmm s ———————- 48
ACCESS CONTROL......ccciisnumemnmmssssssssnsnssmnsmsssssnssssssmmssssssnsnsssnsssssssssnssnssssssssssnnsnnnnsnnss 52
Assign or Change PassWords .......ccucueccussssssssmssmssssmssssmsssssssmsssnssnssnssssnsnsssssasssssnmssssasssnsans 52
Reset @ PaSSWOI ......cccuuiieirismmmssmssnssmsnssssnsssssmsnssssmssssmssssssnsssssmssssns nsssnsssasmsssssnnssnsnnsnse 55
FIRMWARE UPDATE ......ccoiiisesemnsmmmssmsssssnssssmnsnssssnsssssss nsssssnnssssssnnssssnnnnnssssnssnsnnnnnsnsnns 56
Checks after Firmware Update .....cccccuemmmmmmsssenmmmsssssenmmsssssssnnmssssssnsessssssssansssssasansssssassnns 57
FACTORY RESET ....ccietumssasmssmmssnssmssssasnsssssnsssmssnssssnsssnsssssssnssnssssnssssssnnssssssnnnssssssnsanssn 59
ADVANCED MONITORING .....cccutirmmimssmsmmmmnmmssssssnmsmssmssnsssssnssmsessnsssssnnnmsssnnsssssnnnnnsnsens 61

viii DLSENTINEL ;)AtﬁsenSlnC,



PREFACE

ABOUT THIS MANUAL

This User’s Manual is provided for users seeking advanced technical information, includ-
ing connection, programming, maintenance and specifications. The Quick Reference
Guide (QRG) and other publications associated with this product can be downloaded
free of charge from the website listed on the back cover of this manual.

Manual Conventions

The following conventions are used in this document:

The symbols listed below are used in this manual to notify the reader of key issues or
procedures that must be observed when using the reader:

Notes contain information necessary for properly diagnosing, repairing and
operating the reader.

NOTE

The CAUTION symbol advises you of actions that could damage equipment
or property.

>

CAUTION

The WARNING symbol advises you of actions that could result in harm or
injury to the person performing the task and/or persons in the vicinity of

the source of danger.
WARNING
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PREFACE

TECHNICAL SUPPORT

Support Through the Website

Datasensing provides several services as well as technical support through its website.
Log on to (www.datasensing.com).

For quick access, from the home page click on the search icon @, and type in the name of
the product you’re looking for. This allows you access to download Data Sheets, Manu-
als, Software & Utilities, and Drawings.
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CHAPTER 1

DLSENTINEL GRAPHIC USER
INTERFACE

PROGRAM DESCRIPTION

DLSentinel is a User Interface client application that provides device configuration for
the Laser Sentinel series of safety laser scanners. It is installed in and runs on Windows-
based PCs, and connection takes place through an Ethernet TCP/IP interface.

B2 = ? UEEEB

Help. Task Selection
Getting Started E New Safety System configuration
e ] Creato a now Safty System confguration

Open a Safety System configuration from PC
Edt a Safety System configuraton saved on PC

Modify Safety System configuration from a scanner on the network

Edta Safety System configuraton rom a scanner on the network

Wonitor Safety System
Montor a scanner on the network

Read a Safety System report from a scanner on the network
Show a Safaty System regert from a scannar on the network

Read a Safety System report from PC
Mo a Safety System repor from PC.

Main features
A summary of the DLSentinel main features is listed below:

e Settings for changing the device password and to manage the network configura-
tion

e User and Session Language configuration in real time

e System configuration

e Report

e Manual
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DLSENTINEL GRAPHIC USER INTERFACE

BEFORE USING DLSENTINEL

To employ the device, a safety configuration with the DLSentinel GUI must be created,
where the user will enter all the parameters, configure inputs and outputs and create
monitored areas.

INSTALLING DLSENTINEL

The DLSentinel client application software needs to be installed on your PC to configure
the safety laser scanner.

Minimum System Requirements

To ensure proper interfacing with the system, the personal computer must meet the fol-
lowing minimum requirements:

COMPONENT RECOMMENDED m

Processor(s) Pentium 4 Pentium 4
Clock frequency >=3 GHz >=2 GHz
RAM 2GB 1GB

Free hard drive space 70 MB 70 MB
Monitor resolution 1280x768 1024x768

Supporting Operating System Windows 10, Windows 11

Besides the components listed in the table above, your PC must be equipped with the
following hardware and software drivers:

e Installed Ethernet network card and installed driver

e One free 100 Mbps Ethernet port

Program Installation

DLSentinel is a Datasensing safety laser scanner configuration tool providing several
important advantages:

e Intuitive Graphical User Interface for rapid configuration

e Defined configuration directly stored in the device

e Discovery and IP address setting features to facilitate remote configuration

e Device Monitoring and Controller Simulator

To install DLSentinel

1. On the PC that will be used for configuration, download the free setup file from
the Datasensing website: https://www.datasensing.com/eng/downloads-dw-
82.html
Unzip the file and run the installation program by double-clicking the SetupDISen-
tinel.msi file. The downloaded folder also contains Windows Framework (dotNet-
Fx40_x86_x64.exe) provided by Datasensing in case you need to update your
operating system. Run the .msi setup file first, and only install the framework .exe
file if requested.

2. Follow the setup procedure and accept all terms and conditions required for this
software release.

3. When the installation is complete, the DLSentinel entry is created in the Start > All
Programs menu under “Datasensing” along with a desktop icon.

2 DLSENTINEL DAtlgenSlnG
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INSTALLING DLSENTINEL

4. Before launching DLSentinel, you have to create the network LAN with the same
address as the new device. Follow the connection procedure described in "Modify
Safety System Configuration from a Scanner on the Network" on page 14.

laser scanner through the Ethernet port to perform the configuration and

B A dedicated computer running DLSentinel must be connected to a safety
monitoring features.

NOTE
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DLSENTINEL GRAPHIC USER INTERFACE

DLSENTINEL USER INTERFACE

After launching DLSentinel to configure devices or handle reports, the DLSentinel Task
Selection shows the following main areas:

=18]x

DAUASENSING

New Safety System configuration

Croato anew confiuraton

= Open a Safety System
Edta Safety System

Modify Safety System configuration from a scanner on the network
Eata Safety om a scanner on the netvork

Monitor Safety System
Monitor  scanneron the nevork

Read a Safety System report from a scanner on the network
Show a Safety System repartrom ascanner on the network

Read a Safety System report from PC
Show a Safty System repart fom PC

& & & &

e

Main Menu and Toolbar Area — The DLSentinel main features.

2. Task Selection Area — Presents a list of the tasks that can be performed from

DLSentinel. These selections are also available in the File and the Scanner Menus
(Main Menu Area).

Status Bar — A reserved area that keeps specific information about the connected
device. It displays information on the current network status, the connected
device status, the connector and the application type.

Help Online — A Help Guide that includes all the information and parameters to
create a proper configuration. For the next configuration steps, the help online is

available/visible only by clicking on the dedicated button ? in the toolbar.

4 DLSENTINEL
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Main menu

DLSENTINEL USER INTERFACE

FILE

New Configuration

Open Configuration from PC

Read from PC

Save

Exit

SCANNER

Discovery

Direct Connect

Open Configuration from scanner

Open Shape from file
Apply Configuration

Read from Scanner

Settings

Update Firmware

Window Replacement

OPTIONS

Change Language

DLSentinel Log

Report Settings

Advanced Monitoring

HELP

To create a new Device Configuration

To open a previously saved Configuration on the local
drive

Report: shows a Safety System Configuration Report
saved on PC

Saves the current configuration or report on PC

To exit the DLSentinel user interface

Searches for a Device connected to the Network
(LAN)

To connect to a device by entering its IP address

To open a configuration from a device
To insert a previously saved shape in a zone

To apply a configuration to a connected device

Report: shows a Safety System Configuration Report
saved on PC

Open log from memory scanner

Change Network Configuration
Change Access Controls

Reset Password

Factory Reset

To update the Firmware file

To start the Window Replacement procedure

Allows the user to change the display language used
for DLSentinel in real time. The selected language will
also be used for successive sessions.

Extract Log
Measure Unit
System Coordinate

Allows receiving measurement distance data and
information about the status of the device(s).

User’s Manual

Opens the DLSentinel User's Manual

DATASENSING
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DLSENTINEL GRAPHIC USER INTERFACE

HELP

Instruction Manual Opens the Laser Sentinel Instruction Manual

Opens a window that contains DLSentinel release ver-

About N .
sion information

Toolbar buttons

DESCRIPTION

Getting Started: allows the user to start a session by clicking on one of the
Task Selection options.

Configuration Validator: this tool allows you to check the new configuration
in DLSentinel before sending it to the device. By clicking on this option, a vali-
dation test will be made on the entire configuration in DLSentinel. A pop-up
window will appear displaying either a list of configuration errors or validating
the configuration.

B Save: saves the current configuration or report session.

Monitoring: starts a monitoring session.

=
? Help Online: displays a window that includes the help online guide and it
- shows the parameters depending on the selected configuration step.

Task selection

The right side of the main window includes the list of the Task selection. The list is
explained in the chart below.

DESCRIPTION

New Safety System Configuration: to create a new Safety System Configu-
ration on a Virtual Scanner.

Open a Safety System Configuration from PC: to open and edit a Configu-
ration saved on PC.

Modify Safety System Configuration from a Scanner on the Network: to
edit a Safety System Configuration from a Scanner on the Network.

Monitor Safety System: to enter the monitoring function of a connected
Device.

Read a Safety System Report from a Scanner on the Network: to view,
print or save a Safety System Configuration Report.

Read a Safety System Report from PC: to view or print a Safety System
configuration report stored on PC.

o8 loH
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LASER SENTINEL CONFIGURATION CHECKLIST

LASER SENTINEL CONFIGURATION CHECKLIST

DLSentinel allows creating, testing and validating a device configuration. Complete con-
figuration can only be performed on a connected device (Online).

DAUASENSING

The main steps to configure the Laser Sentinel are:

1. CONFIGURATION: create the configuration through Settings, Outputs, Zone Set,
Inputs, Detection, Profinet/Profisafe, Zones.

2. PROGRAMMING: upload the configuration and generate the report file.

3. MONITORING: test and monitor the device functioning with the new configura-
tion.

4. PROGRAMMING: validate the configuration (accept it or reject it).

shows the following icon indicating that the Laser Sentinel is waiting for
configuration. You need to define a new configuration as described in Chap-
NOTE ter 2, Laser Sentinel Configuration.

U At first connection, the device has no pre-set configuration. The display

WAITING CONF

DAU’&EDSIDG USER'S MANUAL 7



CHAPTER 2
LASER SENTINEL CONFIGURATION

ESTABLISHING ETHERNET COMMUNICATIONS WITH THE

SCANNER

The first thing to do is connect the configuration PC to the Laser Sentinel scanner
through the Ethernet port. There are two different methods of establishing Ethernet
communications with the Laser Sentinel depending on the network restrictions of the
plant in which it is installed.

If the plant provides an Ethernet network to which the Laser Sentinel is connected, then
the Discovery feature can be used by connecting the configuration PC to the network, as
described in "DLSentinel Device Discovery through a Network" on page 9.

If there is no Ethernet network available or it is restricted, then the configuration PC
must be connected point-to-point with the Laser Sentinel and its IP address must be
aligned to the Laser Sentinel default address to establish communication, as described
in "Point-to-Point Configuration PC Static IP Addressing Alignment" on page 10.

point-to-point connection with the factory default IP addresses, as
described in "Point-to-Point Configuration PC Static IP Addressing Align-

NOTE ment" on page 10. This is to avoid any network conflicts in the Ethernet
communication.

B When connecting and using the device with your PC for the first time, use a

Figure 1 - GUI Connector

8 DLSENTINEL
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ESTABLISHING ETHERNET COMMUNICATIONS WITH THE SCANNER

DLSentinel Device Discovery through a Network

DLSentinel has a discovery feature to find the connected device.

1. Click on the Discovery item in the Scanner menu to search for the connected
device. Alternatively, you can select the Modify Safety Configuration item from
the task menu.

=]
# [ oo JT
=)
op 0]
Nguratio

 cantiguraton ora scanner Task Selection

New Safety Syster
Createa

| Opan a Safety Sys n from PC
Edt 2 Sataly Sy c

Modify Safety System configu a scanner on the network
Eata 5 " scannes on ne netwoek

The User Interface opens and displays the device with its own default IP Address
(192.168.0.10). Any other device on the network will also be discovered.

2. Click on the discovered device to place it in the Device Configuration panel. A
warning message will be displayed indicating that the device is not on the same
network and prompts you to align it with the network.

WARNING
Scanner on a different Network, change its own IP
Address?

0K Cancel

DAU’&EDSIDG USER'S MANUAL 9



LASER SENTINEL CONFIGURATION

3. Click OK and then change the IP Address parameters in the Network Configuration
window to align them with your network. Consult your network administrator for
these parameters.

IP Local | 10 2 2 101 |
DHCP | Static v
P | 0 239 . 39 . 144 |
Subnet |255 . 255 0o . 0 |
Gateway | 10 . 239 32 .1 |
IP Address used: 10.239.39.144 10.239.39.145 10.239.39.146 10
0K Cancel

Each Laser Sentinel also reserves the successive IP Address for internal
functions.

NOTE
4. Click OK to accept the new IP Address parameters. The device resets.

5. Click on the Discovery button. DLSentinel will rediscover the device with the new
IP Address.

6. Click on the device to load it into the task area.

7. Click on the white right-pointing arrow on the upper right side on the main panel
to download the current configuration from the device to the PC. DLSentinel is
now connected to the device.

(see Appendix C, Factory Reset), the display will show a “NO CONF” mes-

U If you are connecting the device for the first time or after a Factory Reset
sage until a new configuration is loaded.

NOTE

on page 14 for modifying the current configuration or "Open a Previously
Saved Safety System Configuration From PC" on page 42 for downloading a
NOTE previously saved configuration from the PC.

U See "Modify Safety System Configuration from a Scanner on the Network"

Point-to-Point Configuration PC Static IP Addressing Alignment

It is possible to connect a configuration PC directly to the device using the Ethernet TCP/
IP interface (point-to-point).

10 DLSENTINEL DAtllsenSlnG



ESTABLISHING ETHERNET COMMUNICATIONS WITH THE SCANNER

When connecting and using the device with your PC for the first time, this
procedure is recommended to avoid any network conflicts in the Ethernet
communication.

NOTE

The Ethernet IP Addressing parameters must be aligned between the configuration PC
and the scanner. Please follow the procedure below.

The default Laser Sentinel static assighnment Ethernet IP Address is: 192.168.0.10.

Connect the device to the LAN port of your PC and switch it on.

Before changing the Ethernet network settings on the PC running the GUI, close
any open applications that use network resources (e.g. Outlook, Web browser).

On the configuration PC, from the Control Panel>Network and Internet>Network
and Sharing Center, click on the Local Area Connection link and open the proper-
ties window.

Select the Internet Protocol Version 4 (TCP/IPv4) item and open the properties
window.

Set the IP Address fields as follows: 192.168.0.xx, where “xx” is any number differ-
ing from the device address and click OK to save. The PC is now aligned with the
Laser Sentinel default network.

Internet Protocol Version 4 (TCP/IPwd) Properties M

General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
(@ Use the following IP address:

IP address: 192,168 . 0 . 38
Subnet mask: 255 .255.3255. 0
Default gateway:

Obtain DNS server address automatically
(@) Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[ validate settings upon exit

[ OK ][ Cancel ]

Launch DLSentinel from the configuration PC.

Click on the Discovery button. DLSentinel will discover the device with the default
IP Address.

Click on the device to load it into the task area.

DATASENSING
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LASER SENTINEL CONFIGURATION

9. If Windows Firewall is active on the configuration PC, a pop-up window will
appear after discovering the device.

If no firewall window appears, but an “Unable to connect” message is still
shown, it may be due to the antivirus firewall installed on you PC.
NOTE

Do not close the pop-up window before allowing access to both private and public
networks of the PC to communicate and exchange data with the device through
the Ethernet port.

@& Windows Security Alert *

Windows Defender Firewall has blocked some features of this

HEE

Windows Defender Firewall has blocked some features of DLSentinel on all public and private

networks.
Mame: DL5entingl
Publisher: Datalogic
Path: C:'program files (x86)\datalogic\dlsentinel
2. 1.0"dIsentinel . exe

Allow DLSentinel to communicate on these networks:
rivate networks, such as my home or work network

ublic networks, such as those in airports and coffee shops {not recommended
because these networks often have litte or no security)

What are the risks of allowing an app through a firewall?

If you close the pop-up window before confirming the Firewall authorization, go to Con-
trol Panel>System and Security>Windows Defender Firewall>Allowed apps and click on
“Change settings”.

@ Allowed apps — o
PP

1 i » ControlPanel > System and Security » Windows Defender Firewall » Allowed apps v|@  Search Control Panel P

Allow apps to communicate through Windows Defender Firewall
To add, change, or remove allowed apps and ports, click Change settings.

What are the risks of allowing an app ts communicate? &) Change settings

@ For your security, some settings are managed by your system administrator.

Allowed apps and features:

Name Domain  Private Public ~ Group Policy *
[ Distributed Transaction Coordinator [m] [m] ) No
[W]DLSentinel No
nail and accounts No
[ Feedback Hub No
File and Printer Sharing [} m] No
[IFile and Printer Sharing over SMBDirect [} [} m] No
M Get Help No
M Google Chrome No
M Groave Music No
[ HomeGroup | | m} Mo
[i5Cl Service O ] [m] No
[Z KD Service Port O o No ©
Details... Remove

Allow another app...

oK Cancel
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ESTABLISHING ETHERNET COMMUNICATIONS WITH THE SCANNER

Scroll down the list and check the boxes on the DLSentinel row as shown in the figure
below, then click OK. The Firewall is now disabled on DLSentinel.

DATASENSING

@ Allowed apps — m]

A P » Control Panel » System and Security » Windows Defender Firewall » Allowed apps | &| | search Control Panl £

Allow apps to communicate through Windows Defender Firewall
To add, change, or remove allowed spps and ports, click Change settings.

What are the risks of allowing an app te communicate? &) Change settings
{0 For your security, some settings are managed by your system administrator.

Allowed apps and features:

Name Domain  Private Public  Group Policy *

%) DL Sentinel

M Email and accounts

[ Feedback Hub

MFile and Printer Sharing

[File and Printer Sharing over SMEBDirect
M Get Help

[ Google Chrome

®

M Groove Music
O HomeGroup
L1355 Service
FIKD Service Port

HODENKEDOREX

OODO0DEREOOE®

O0DNREOO0R®
z

No e

Details... Remove

Allow another app...

If you cannot find DLSentinel on the program list, uninstall and reinstall the
software and follow the procedure described in point 9.

NOTE

10. Back on DLSentinel, click on the white right-pointing arrow on the upper right side
on the main panel to download the current configuration from the device to the
PC. DLSentinel is now connected to the device.

If you are connecting the device for the first time or after a Factory Reset
(see Appendix C, Factory Reset), the display will show a “WAITING CONF”

message until a new configuration is loaded.
NOTE

See "Modify Safety System Configuration from a Scanner on the Network"

on page 14 for modifying the current configuration or "Open a Previously

Saved Safety System Configuration From PC" on page 42 for downloading a
NOTE previously saved configuration from the PC.
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LASER SENTINEL CONFIGURATION

MODIFY SAFETY SYSTEM CONFIGURATION FROM A
SCANNER ON THE NETWORK

1. Click on Modify Safety System Configuration From a Scanner on the Network task
to edit a configuration on a device on the Network (Online Configuration).

DIEFEER m
Get tarte e
el

|
DLSentinel will enter Discovery mode to search for a connected device.

# AD = 7 ‘!!!gg!!ﬂ’
Help jon

# & He 00

set the network configuration settings. See "Establishing Ethernet Commu-

U If the Laser Sentinel and the PC LAN are not aligned, it will be necessary to
nications with the Scanner" on page 8.

NOTE
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

2. Click on the white right-pointing arrow on the upper right side on the main panel
to download the current configuration from the device to the PC. DLSentinel is
now connected to the device.

DAUASENSING

DAU&EDSIDG USER'S MANUAL 15



LASER SENTINEL CONFIGURATION

Configuration Settings

The first page is the Configuration Settings page, which contains information about the
application.

DAUASENSING

Scenario to select the configuration type (depending on the application).

e Vertical: Same as expert but requires that Reference Points be defined in the Zone
configuration (they are not optional for Vertical applications).

e Expert: provides the maximum configuration possibilities for the device. It con-
tains the entire set of parameters, regardless of the device use.

It is possible to view and edit some of the parameters in the Configuration section, such
as:

e Name: A name to identify the configuration.

e Author: A name to identify the author.

e Description: A short text description to identify the configuration.

e DLSentinel Version: (Read-only). The software version of DLSentinel.

o Safety Signature: (Read-only). This is a 16-byte unique identifier randomly gener-
ated by DLSentinel based on the time and date when the configuration is down-
loaded into the scanner.

e Creation Date: (Read-only). The date and time the configuration was created.
e Scanner: A name to identify the scanner.

on the upper right side on the main panel. To go back to the previous page,

U To proceed with the configuration, click on the white right-pointing arrow
click on the white left-pointing arrow.

NOTE

16 DLSENTINEL
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

Output Configuration

The Output Configuration page displays the following parameters for the SLS-Fieldbus
models:

DAUSENSING

Output Functions
Safety Zone: to select the number of Safety Zone to be monitored within the
active zone set (up to 8).

Warning Zone: to select the number of Warning Zone to be monitored within the
active zone set (up to 7).

Clean Window: if enabled, the “Clean Window” device error/warning is output on
the selected pin.

Device Error: if enabled, any device error is output on the selected pin.

Auto Reset: if enabled, the scanner will automatically reset after 10 seconds from
the error condition and will resume normal operation. The Auto Reset function
will be permanently inhibited if the device locks in INTFx more than 5 times with-
ing 15 minutes. In this case a power cycle is necessary to reactivate the scanner.

Auto Reset can be configured in the Output Configuration page, but it is not
an output function.

NOTE

Muting Function: if enabled, the safety laser scanner can operate under con-
trolled conditions where an object can pass through the Safety Zone without the
scanner switching to the Off-state.

Override Function: if enabled, when the muting function is enabled, the safety
laser scanner can enable override to force the safety function deactivation to clear
the safety zone form a work cycle anomaly.

Override Status: when the override function is active, the status of override is sig-
naled. Override status is valid on output pin only for Safety Zone 1.

Muting Lamp: if the Muting function is enabled for Safety Zone 1, an optional
muting lamp can be connected to a scanner output signal to indicate when the
scanner is functioning in Muting (dangerous area temporarily unprotected) or
Override for the Safety Zone 1 only.

The maximum number of Safety Zone, Warning Zone and Muting shall be 8
(e.g., 3 Safety Zones, 3 Warning Zones, 2 Muting zones is an allowed con-
figuration).

NOTE

DATASENSING
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LASER SENTINEL CONFIGURATION

Safety Zone 1

Only for the Safety Zone 1, Physical Configuration can be enabled to allow the user to
select output signals for Override Status and Muting Lamp when they are enabled.

Safety Zone 2...8

The Muting and Override function can be enabled or disabled according to the con-
straint of maximum 8 among Safety, Warning, Muting zones. These functions are han-
dled by the Fieldbus protocol through the Process image.

Output signals

This parameter group assigns the signals of the output functions to the scanner pins
only for the Safety Zone 1 if Physical configuration is enabled, except for Clean Window
and Device Error which can be always assigned.

Each pin is also associated with color-coded cable wiring according to safety equipment
regulations and standards.

The following pins are available for the Safety Laser Scanner Fieldbus:
e Pin 1 (White Wire), Pin4 (Yellow Wire), Pin 5 (Gray Wire), Pin 6 (Pink wire)

If an alarm is enabled, these pins can be assigned to the Clean Window or Device Error
output. If the Override Function is enabled (Muting function enabled), these pins can be
assigned to the Override Status. If Muting Lamp is enabled (Muting function enabled)
these pins can be assigned as the Muting Lamp output. Otherwise, they must be
assigned here as No Function.

18 DLSENTINEL
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

Zone Set Configuration

The Zone Set Configuration page displays the following parameters for the SLS-Fieldbus
models:

DAUASENSING

Zone Set configuration

Zone Set Parameters

e Zone Set No.
To select the number of Zone Sets to use for the configuration. The default value is
one Zone Set (no Area Switching). By pressing the up arrow more Zone Sets can be
added. Please note that you can select max. 70 Zone Sets for SLS-Fieldbus models.

e Sequence control
If more than one zone set (Zone Set No.) is selected, the Sequence control can be
ENABLED or DISABLED by the user. If ENABLED, the change of zone set from x toy
shall be admissible only for a sequential number of the zone set (incremental or
decremental), i.e., y=x+1 or y=x-1. If the user tries to activate a different zone set
from y=x+1 or y=x-1, the device goes to a safe condition and the error INPUTCF3 is
shown on the display.

E.g.: if three zone sets are configured, if Sequence control is ENABLED, zone set
No.3 shall be activated only if the current zone set active is the zone set No. 2. or
zone set No. 4.

When the maximum number of configured Zone Set is reached, the next incre-
mental admissible Zone Set is the first one, otherwise, if Zone Set No. is set to 0
the error INPUTCF2 is shown on the display.

E.g.: if three zone sets are configured, if Sequence control is ENABLED, after zone
set No.3, the next incremental admissible zone set is the zone set No. 1.
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Input Configuration

The Input Configuration page displays the following parameters for all the Safety Zones
defined:

DAUASENSING '

= Configuration  Programming  Monitoring

Input configuration

—P routrncrons o g
sl s v e
Restart mode | AUTOMATIC C
= e ¢ ceov N
Recovery time [msec] 200 2
Pind NO FUNCTION v Yellow (YE)
Physical ontiguration
T v owon RN

PN NOFUNCTION v Pink (PK)

CONNECTED 8 PIN CONNECTION SCANNER STATUS: WORKING SCANNER IP: 162.168.0.10

If the Physical Configuration is ENABLED (for Safety Zone 1), the Input Configuration
page displays the following parameters:

= Configuation  Programming  Monitoring

Input configuration

ISR | satety Zone 2 Pin1  NOFUNCTION v White (WH)

Pn3  [NOFUNGTON v oenow

Pind | NOFUNCTION v Yeliow (YE)

Pns  NOFUNCTION = - @ |

Pin6  NOFUNCTION v Pink (PK)

Restartmode  AUTOMATIC

Recovery time [msec] 200

Muting type  BIDIRECTIONAL

Max Muting activation delay [sec] 4

Timeout [min] - (0 for no timeout) 10

<| [ [P [ <] [<B

Override mode  SINGLE LINE PATTERN

Physical Configuration

CONNECTED 8 PIN CONNECTION EXPERT SCANNER STATUS: WORKING SCANNER IP: 162.168.0.10

Input Functions

Restart Mode: for each Safety Zone it's possible to select the restart mode.
-Automatic: the Laser Sentinel automatically returns the SafetyStatusZone bit of
the process image to 0 after all detected objects are removed from the Safety
Zone and the configured Recovery Time elapses.

-Manual: the Laser Sentinel returns the related SafetyStatusZone bit of the pro-
cess image to 1 after all detected objects are removed from the Safety Zone and
the related RestartSafetyZone bit is set to O after a transition 0-1-0. (see Instruc-
tion Manual for details) by the controller. When the objects are removed, the
InterlockReqgZone bit is set to 1 in the Process Image (by the SLS) to inform the
controller that Restart is possible. Only for the SafetyZonel, if Physical Configura-
tion is enabled, a manual Restart switch (push-button) can be used on the selected
pin and shall be pressed for at least 500 msec. If the Restart switch is pressed
while an object is still inside the Safety Zone, the Laser Sentinel switches to a fail-
ure lockout state and must be Reset.

Recovery Time: this parameter is only significant for Automatic Restart Mode. The
recovery time is the time between the object removal from the Safety Zone and

20 DLSENTINEL
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

the SafetyStatusZone bit achieving the value 1. The minimum Recovery Time is
200 msec. This can be increased to 60000 msec in 1 msec increments.

Only for the Safety Zone 1, if Physical Configuration is enabled:

e Muting Type: the Muting function can be used in two different configurations:
-Unidirectional: this is when objects can pass through the Safety Zone from only
one direction. It requires two Muting sensors be connected to the Laser Sentinel
inputs.

-Bidirectional: this is when objects can pass through the Safety Zone from both
directions. It requires four Muting sensors be connected to the Laser Sentinel
inputs.

e M coeff.: for Unidirectional Muting, the M coefficient is the delay multiplier that
causes the Muting function to end. This is the multiplier of the activation delay
between the two sensors. It can be set from 2 to 16.

¢ Max Muting Activation Delay: this is the maximum delay between the Muting
sensors activation that will still allow the Muting function to be enabled. If the
second Muting sensor is activated after this max. delay, the Laser Sentinel will not
enter Muting.

e Timeout: this defines the maximum duration for the Muting function regardless of
the Muting sensors state. The values range from 10 to 1080 minutes. If set to O,
the Muting function is indefinite. This means that Muting will continue as long as
the Muting conditions exist.

Attention: User is warned that the latter setting is not compliant with IEC 61496-1.

e Override: when the Muting function is enabled, enabling the Override input
allows forcing the safety function deactivation to clear the safety zone from a
work cycle anomaly.

¢ Override Mode: the available override modes are single line pattern, edge, and
trigger. See the Laser Sentinel Instruction Manual for details.

Input Signals

This parameter group assigns the signals of the input functions to the scanner pins. Each
pin is also associated with color-coded cable wiring, according to safety equipment reg-
ulations and standards.

The following pins are available

e Pin 1 (White Wire), Pin4 (Yellow wire), Pin5 (Gray wire), Pin6 (Pink wire)
If these pins have been assigned as Alarm, Override Status or Muting Lamp out-
put, they are not available. If they haven't been assigned yet, they can be assigned
to one of the Muting input signals, the Muting Override input signal or as a man-
ual Restart or Reset input. If these inputs are not used, select No Function.

e Pin 3 (Green Wire)
This pin is only input, it can be assigned to one of the Muting input signals, the
Muting Override input signal or as a manual Restart or Reset input.
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LASER SENTINEL CONFIGURATION

Detection Configuration

The Detection Configuration page displays the following parameters:

ft BB ?

g

Detection Parameters

e Anti-interference coding: This parameter changes the scan cycle time (default =
42ms for maximum of 4 Safety + Warning zones). This helps avoid interference
among scanners working in the same environment.

e Number of Scans: Select the number of scans required to validate detection. This
parameter has a direct impact on the Response Time, which is the time from
when an object is detected in the Safety Zone to when the StatusSafetyZone bit of
the Process Image is set to 0. The Response Time ranges from 94 to 2065 ms
according to configuration. Check the chapter “Response Time and Scan Cycle Set-
tings” of the Instruction Manual for further details.

e Detection Capability: The ability to detect an object of given dimensions within
the detection zone. Objects greater than or equal to the selected value can be
detected both for the Safety and Warning Zones.

e Anti-Tampering Delay: choose whether to enable the function and the delay time
for its activation.

e Measurement Filter: a median filter on the measurement can be enabled or dis-
able to have smoothed corners of the object detected.

e Dust Filter Level must be set according to different conditions specific to the
application. In general, it is the sensibility to various levels of airborne particles
that impact the response of the Laser Sentinel detection.

-High Dust Filter Level is used in dirty environments to filter (ignore) detection of
airborne particles from being confused with objects to detect. The Laser Sentinel
is less sensitive to dust and therefore avoids shutting down the machinery unnec-
essarily.

-Mid

-Low Dust Filter Level is used in cleaner environments where airborne particles
have little effect on object detection.

Dust Filter Level should be set to the lowest value that still allows the machinery to
work without detections due to dust.
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ment, some special lighting conditions also affect the detection sensibility.

U In addition to the level of airborne particles in the Laser Sentinel environ-
These conditions are:

NOTE « high reflective backgrounds within 3 meters of the Safety Zone

boundary,
o the presence of bright light within +/- 5 ° of the detection plane.

The additional distance must be included in the Minimum Safety Distance
calculations for these cases.

s is an exception to the product standard that must be evaluated by per-
sonnel experienced in the functional safety of the application in order to
NOTE  verify the risks and take appropriate countermeasures.

U Disabling the Anti-Tamper function or selecting a delay time longer than 5

Profinet/Profisafe Configuration

FBUS connectors

Figure 2 - Fieldbus connector

PROFINET/PROFIsafe configuration page shows the following parameters:

DAUASENSING
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Profinet Network Settings:

e F-destination address: unique address for the SLS within the Fieldbus network.

e F-1/0 Data: define the 1/0 cyclic data to be exchanged between the SLS and the
controller (7 or 12 byte Input/Output). It is possible to select only output data (7
or 12 byte Output, from SLS to the controller). In this condition, any input cyclic
data from the Controller is neglected and only one Zone Set is configurable.

Profinet/Profisafe Settings and Alarms to PLC

e Profinet Settings: define the settings of the SLS within the PROFINET network.
-Profinet Name: Allows you to assign a PROFINET name that is unique in the net-
work. The name may not be in use already for another device in the PROFINET
network. It can only contain lowercase letters, numerals, and periods and
hyphens. The DLsentinel stores the PROFINET name retentively in the device.

The PROFINET name, F-Destination address and F-1/0 data changes are
valid only after a power cycle of the device.

NOTE

-Function Tag, Location Tag, Installation Date, Descriptor: Identification&Mainte-
nance parameter for the identification and maintenance function within the
PROFINET network.

These parameters are not sent to device with the DLSentinel configuration but
they can be read or sent directly from/to device through the related buttons.

If the values in the DLSentinel and the values in the device differ, you can read
(Read from device) the values out from the SLS and adopt them in the DLSentinel.
Alternatively, you can transmit (Send to device) values from the DLSentinel
directly to the device.

e Scanner Info: the F_iPar_CRC stored in the device can be read. If a process image
with check of F_iPar_CRC is used, the F_iPar_CRC value must be provided in the
software configuration of the controller (e.g. PLC).

e Manufacturer Alarms: define which manufacturer specific Alarms shall be trans-
mitted to the PLC within the process image (see Instruction Manual for details
about the classification of alarms). If the respective check mark is set, the alarm, if
present, is transmitted to the controller. Otherwise, if the respective mark is not
set, the alarm, if present, is not transmitted to the controller, but the error is
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

shown on the display and the device goes in an error state accordingly to the
alarm occurred.

DATASENSING

Profinet/Profisafe configuration

CONNECTED 8 PIN CONNECTION EXPERT SCANNER STATU: SCANNER IP: 162.168.0.10
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LASER SENTINEL CONFIGURATION

Zones Configuration

In the Zones Configuration, tools are provided to draw the Safety and Warning Zones as
well as Reference Points. It is possible to select different shapes and different functions
to manage the areas on the graph.

The panel on the left side allows selecting the areas to handle on the graph (Safety,
Warning, or Reference Points) and managing them individually. See the paragraph on
Selecting and Visualizing Areas on the Graph.
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This is the last step in defining the configuration. To complete configuration
(load it onto the scanner, test it and Accept it), see Chapter 3, Program-
ming and Monitoring Functions.

NOTE
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

[ot0] )\ DESCRIPTION

gg Click this button to free-hand draw an area by holding pressed the left button of

the mouse and dragging it across the graph. Once finished, release the left but-
ton.

DAt/ssens:nE, '

z figuratior »/
o <
e °
0 o e v

AL = ™~ L]
- T 5
4 1

/ N =t

o / \ o
\ Vi

| / : ¥
/ Q \ g

T \ ©
I &

‘ b

ICON DESCRIPTION

Click this button to draw a straight-edged area by holding pressed the left but-
\ ton of the mouse and dragging it across the graph. Once finished, release the
left button.
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LASER SENTINEL CONFIGURATION

ICON DESCRIPTION

. Click this button to draw a circle shaped area with its center at the scanner by

holding pressed the left button of the mouse and dragging it across the graph.
Once finished, release the left button.
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ICON DESCRIPTION

of the mouse and dragging it across the graph. Once finished, release the left

' Click this button to draw an arc shaped area by holding pressed the left button
button.

DAUASENSING

Zones configuration »/
o N\
o ®

e v
't T L]
e 4
- X K
o L8 o
\ ¥
o \
\ 4
- \ =
\ @
| (<]
| | A
o \ /
\ /
on \ /
\ /
\ 7
- 5 /
N\ y
Al L /
\ ) 7
i iy ///

28 DLSENTINEL

DATASENSING



MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

[ot0] )\ DESCRIPTION

Click this button to draw a polygon shaped area. Left-click and release the
mouse button on a point in the graph and drag the mouse to draw the area.

. Left-click again to start the next edge of the polygon area. Once finished, dou-
ble-click the left button.
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LASER SENTINEL CONFIGURATION

ICON DESCRIPTION

_-'+I Click this button to draw Reference Points.
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To activate this function, select the REFERENCE POINT area on the left
pane.

NOTE

Specify the distance tolerance of the reference point from the scanner along the ray
(“4+” means farther from the scanner, “-” means closer to the scanner).

There must be a minimum of 3 and a maximum of 15 Reference Points. Reference
points monitoring is a safety function used to monitor any change in position of the
scanner, a protective structure or a moving structure located at the specified reference
point. These structures either allow or prevent access to the dangerous area and are
therefore outside the monitored Safety Zone. When the device detects a change in posi-
tion at the Reference Points exceeding the specified tolerance, the safety function is
activated. This function is required for Vertical applications. See the Laser Sentinel man-
ual for more details.
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

ICON DESCRIPTION

«====s Click this button to create a selection and resize a group of selected points. The

' i points included in the selection will turn red. Drag and drop one of them to edit

w====f  the whole group.
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LASER SENTINEL CONFIGURATION

ICON DESCRIPTION

{ } Click this button to draw an area by selecting the type of shape (circle, arc or
Xy polygon) and directly inserting the measurements and coordinates.
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Acting on Drawn Objects

Once the area has been drawn, it is possible to access an edit menu by right-clicking on
the selected area. This menu allows:

e copying a drawn object between Warning and Safety of the same Zone
e moving a drawn object between Warning and Safety

e of the same Zone

e saving a drawn object

e deleting a drawn object
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

[ot0] )\ DESCRIPTION

Click this button to move (drag) the graph in any direction. Once finished, re-
click on the button.
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ICON DESCRIPTION

Click this button to toggle the graph unit of measurement between inches and
millimeters.
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LASER SENTINEL CONFIGURATION

ICON DESCRIPTION

El_l Click this button to zoom in on the graph. Clicking multiple times continues to

zoom in.
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ICON DESCRIPTION

Click this button to zoom out on the graph. Clicking multiple times continues to
zoom out.
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

ICON DESCRIPTION

% Click this button to toggle the graph coordinates between Cartesian and Polar.
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ICON DESCRIPTION

Click this button to enter the Teach In feature. This function scans and shows
the area surrounding the device. It displays a white area that is free from obsta-
cles and therefore can be assigned to a safety or a warning zone. The grey
areas are detected obstructions.
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LASER SENTINEL CONFIGURATION

ICON DESCRIPTION

This function is the Teach In Area Assignment, to assign a zone type to the
detected white area. After choosing Teach In, select the checkbox of either the
safety zone or warning zone in the left pane and then click this button to assign
it.
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Teach In and Draw Teach in Zone are only available if the device is online.

NOTE

ICON DESCRIPTION

{ Click this button to add a new point to a shape. The new point must be inserted
+

along the shape perimeter.
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

ICON DESCRIPTION

;i’ll: Click this button to remove a point from a shape.
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ICON DESCRIPTION

[aa] Click onapoint on the graph and drag the cursor to measure the distance.
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LASER SENTINEL CONFIGURATION

ICON DESCRIPTION

)I Click this button to show reflective objects. These will be shown in purple.
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ICON DESCRIPTION

o c Click one of these buttons to rotate the view 45 degrees to the left or to the
right.
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It is also possible to flip the view by checking the “Upside down” box.
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MODIFY SAFETY SYSTEM CONFIGURATION FROM A SCANNER ON THE NETWORK

Selecting and Visualizing Areas on the Graph

The panel on the left side allows selecting the areas to handle on the graph (Safety,
Warning, Muting, or Reference Points) and managing them individually.
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By clicking on the label name (outside the check box), it is possible to highlight a specific
area, e.g. a Safety Zone or a Warning Zone.

By clicking on the checkbokx, it is possible to select and edit a specific area.

The combination of these selections allows you to show/hide the areas together or indi-

vidually.
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This is the last step in defining the configuration. To complete configuration
(load it onto the scanner, test it and Accept it), see Chapter 3, Program-
ming and Monitoring Functions.

NOTE
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LASER SENTINEL CONFIGURATION

NEW CONFIGURATION SELECTION

1. Click on the New Configuration task to create a new configuration and save iton a
local PC for upload to a device at a later time (Offline Configuration).

Options  Help -1ox

A B> E? DAUSENSING
Help Task Selection

Getting Started i New Safety System configuration
R N e h| s &

() Open a Safet
Edta satay
Modify Safety System configuratior
£t s Saaty System confurat

Monitor Safety System
oniar & scanneton th network

Read a Safety System report from PC
Show a Saley System roport Fom PC

2. Click on the device in the catalogue list to load it into the task area.

DAUASENSING

o

3. Click on the right-pointing arrow on the upper right side on the main panel to
open the offline configuration. You can now create your configuration and save it
on your PC. See the subparagraphs under "Modify Safety System Configuration from
a Scanner on the Network" on page 14 for configuration details.

4. Save the configuration on a file on your PC. See "Save the Configuration" on page
41,
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SAVE THE CONFIGURATION

SAVE THE CONFIGURATION

Once the configuration is done, it is possible to save it on the PC by clicking on File >
Save.
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LASER SENTINEL CONFIGURATION

OPEN A PREVIOUSLY SAVED SAFETY SYSTEM
CONFIGURATION FROM PC

1. Click on the Open a Safety System Configuration from PC task to open and upload
a previously saved configuration onto a device.

2. Select the Configuration File to open.

DAU&Ens:nb
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OPEN A PREVIOUSLY SAVED SAFETY SYSTEM CONFIGURATION FROM PC

3. Once the configuration is open, click on the Programming item. The Discovery pro-
cedure will discover the connected device.
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4. Click on the device to load it into the task area.

,,,,,,,, =
s D0 g LN 55455 A OFHETPROFR ;
oeuo seunge

E SLswsopaa o3 suus @ pmwm w2580.10 b
192.168.0.40 =

5. Click on the white right-pointing arrow on the upper right side on the main panel.

The Programming page will appear. Here you can Load the selected configuration
to the scanner.

DAUSENSING
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Laser Sentinel

First the configuration will be validated and then you will be prompted to enter
the password to change the current configuration to the new one.
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LASER SENTINEL CONFIGURATION

6. Enter the password and click OK.

DAUASENSING '

Programming
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DAUSENSING
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7. The scanner status will now switch to Off-Duty and the user is prompted to con-
tinue to load the new configuration onto the scanner.
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Programming
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DAUASENSING

Laser Sentinel

8. Click on the Monitoring item to verify the configuration. See "Monitoring And Con-
troller Simulator" on page 48.

9. Then click on Programming to Accept the new configuration and finalize it. See
"Programming" on page 45.
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CHAPTER 3

PROGRAMMING AND MONITORING
FUNCTIONS

PROGRAMMING

Programming is a DLSentinel function that allows uploading a configuration to the
device, generating the Safety Report and validating the uploaded configuration (after
testing it through the Monitoring function, refer to "Monitoring And Controller Simulator”
on page 48.

The steps below show a proper Programming procedure:
1. Once the configuration has been created or loaded from the PC, enter the Pro-

gramming function.
A Report file is generated by DLSentinel.

DAUASENSING
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DAUASENSING

Laser Sentinel

The Safety Report is a file that sums up all the parameters selected for a configura-
tion and is generated by DLSentinel after uploading a configuration. The Report
file is displayed on the right side of the panel. It is possible to save it as a PDF file
and print it.

Make sure to read the Safety Report and check all the selected parameters.

The Safety Report displays the new and the previously used parameters
(marked in red).

NOTE
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PROGRAMMING AND MONITORING FUNCTIONS

2.

In the Configuration Upload section, click on the Load button to upload the con-
figuration from the PC to the device. First the configuration will be validated and
then you will be prompted to enter the password to change the current configura-
tion to the new one.

DAUASENSING

pee aac

While uploading the configuration onto the device, Laser Sentinel will enter the
Off status. In this status, the connection to the controller (e.g.PLC) is not guaran-
teed.

Once the new configuration is uploaded, Laser Sentinel will display an icon with a
white background like the one below indicating that the configuration is pending
acceptance by the user if the Process Image is set as only output (7 Bytes (SLS out-
put) or 12 Bytes (SLS output)).

For Process Image Input/Output, the WAIT FOR INPUT icon is show on the display
and the behaviour of the device can be tested by using the Controller Simulator in
the “Monitoring” section.

GO

Figure 1 - Example Pending Configuration Acceptance Icon displayed

3. Test the configuration functioning by entering Monitoring. See "Monitoring And

Controller Simulator" on page 48.

46
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PROGRAMMING

4. After testing it and checking the Report, Accept or Reject the configuration in the
Validation section.
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Programming

B = Qac

DAUASENSING
Laser Sentinel

After Acceptance, the configuration will be finalized on the device. Laser Sentinel
will display an icon with a black background like the one below indicating that the
configuration has been accepted by the user.

Figure 2 - Example of configuration accepted icon displayed.

By validating the configuration, you take on responsibility for the created
configuration and accept any hazards due to configuration errors.

WARNING

If you Reject the new configuration, the previous configuration will be
finalized on the scanner.

NOTE
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PROGRAMMING AND MONITORING FUNCTIONS

MONITORING AND CONTROLLER SIMULATOR

Monitoring is a DLSentinel function that allows you to check the proper functioning of
created configuration by monitoring the current working area.

Controller Simulator is a DLSentinel function that allows to simulate the fieldbus proto-
col without the use of a controller (e.g. PLC). Itis possible to monitor the cyclic data sent
by the SLS and to send data to the SLS as if the DLSentinel were a fieldbus controller.

Functions activation (e.g. zone set switching, muting, etc..) by Controller Simulator,
when enabled, excludes any interaction with the real controller. Any input received by
the controller will be neglected as long as the Controller Simulator is enabled.

The use of Controller Simulator is recommended for test and simulate the
configuration only. It is not recommended while the Laser Sentinel is com-
municating with a real controller (e.g., PLC).

WARNING

The access to these two functions is allowed only by selecting an online device.
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With the monitoring function, the following information can be checked:

Status of Safety Zone (GO/STOP).

The connector pin assignment, colors and functions.

If the Laser Sentinel detects an object in the Safety and Warning zones.
Any diagnostic errors.

The surrounding space detected by the device in real time.

The switching among the Zone Sets.

The selected Parameters.
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MONITORING AND CONTROLLER SIMULATOR

On the panel at the lower left corner, DLSentinel shows the device
status (if it is correctly functioning). It is also possible to view some
parameters, e.g., the pin assignment, the response time. The virtual
LEDs of the configured zones (Safety, Warning) reply to the behavior
of the virtual LEDs shown in the display of the device (for detailed
information, please see the Instruction Manual).

20NE SETS 1

The Controller Simulator on the left side of the detection area of the Laser Sentinel
shows the following areas:

. Process Image Input Test Mode

Byte Hex Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0
Bteoo ox00 ¥ ¥ ¥ ® @ @0 ® @
Bteol 01 [0 @ 0@ @ 0@ @ © @
Bteoz 0x00 [0 @ @ @ 0@ @ © &
Bteod x00 ¥ O O @ 0@ @ © &
Bite04 (0x00 ) (o) [0 (@ (@ (@ (@ (@
Bteos 00 0 0 B 0 @ ® ®© ®
Byteos 000 ) 0 B 0 ®© ® @ @

Process Image Output

Byte  Hex Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0
Byteoo 0x00 0 @ @ 0 @ [ @ @
Byte0l 0x01 [0 @ @ @ © © © @
mez 7 OO0 000 E@EG
meos 000 OO O0OO0O00DO
eos 00 0 OO0 00O E@E
peos 000 OO0 00 0@ @ O
gyteos ox00 0 O O O O O [0 [o
Bit Color

[ Bit Area Switch No. [ Bit Inferlock

[ Bit safety Bit Warning

[ Bit Muting [T eit overide

[¥] Bit Reserved [CJ Bit Not Configurated

[ sit Standard

1. Test mode - The Controller Simulator can be activated by switching the slider but-
ton to On. During the Acceptance phase of a new configuration, the Test Mode is
always On and cannot be deactivated.

2. Process Image Input - Presents the bitmap of the process image input (sent by the
Controller to Laser Sentinel) according to the configuration (e.g., 7 Bytes Input/
Output) defined in the Profinet/Profisafe section.
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PROGRAMMING AND MONITORING FUNCTIONS

3.

5.

Process Image Output - Presents the bitmap of the process image output (sent by
the Laser Sentinel to Controller) according to the configuration (e.g., 7 Bytes
Input/Output) defined in the Profinet/Profisafe section.

Editable Input Bytes - Presents the editable fields (in hexadecimal format) of the
process image input to simulate the controller data sent to the Laser Sentinel

Legend - A color legend of the Process Image bitmap

To facilitate the interpretation of the process image, the user can move the cursor to the
interested bit and a tooltip will show the meaning of the selected bit.

‘ Process Image Input Test Mode
Byte  Hex Bit7 BitG Bit5 Bit4 Bit3 Bit2 Bit1 Bit0
Byte00 0x00 [ [ [ B (@ (@ & (@
Byte01 0x01 [0) (o) [0 (@) (@ (@) (o)
Bﬁeuzuxnu@@@@@@ﬁl% :
Byte 03 0x00 E @ @ @ m @ E] Area Switch Mo,
Byte04 0x00 () (o] (o] (o (o (o (o (o
Byte05 0x00 [ ¥ (¥ 0 ® B X X
Byte06 0x00 [J [d [ 0 (& (0 (@ (2

By activating the test mode, the user can edit the Input Bytes to test some functions of
the device before the integration in a fieldbus network with a real controller (e.g., a

PLC).

The main functions that can be simulated are:

Wink.

Zone set activation (“Area Switch No.”).

Restart of the safety zone configured with manual restart (“Restart Safety Zone
X”).

Muting activation for the safety zone configured with muting (“Muting Activation
Zone X”).

Override activation for the safety zone configured with override (“Override Acti-
vation Zone X”).

A Shut-off function, Reset With and Without Network cannot be activated

when using the Controller Simulator.

WARNING

N

It is possible to write the reserved bits also, but this action has no effect on
the Laser Sentinel.

NOTE

U If Monitoring is selected before uploading a new configuration, it displays

the previous configuration.

NOTE

50 DLSENTINEL

DATASENSING



DATASENSING

MONITORING AND CONTROLLER SIMULATOR

The table below shows the Monitoring menu.

ICON DESCRIPTION

+ 0 Py D

inch

C

Upside
down

NOTE

NOTE

Click this button to save the Monitoring info in a text file (.txt).

Click this button to show reflective objects. These will be shown in purple.

Click this button to zoom in on the graph. Clicking multiple times continues to
zoom in.

Click this button to zoom out on the graph. Clicking multiple times continues
to zoom out.

Click this button to move (drag) the graph in any direction. Once finished re-
click on the button.

Click this button to toggle the graph unit of measurement between inches and
millimeters.

Click this button to toggle the graph coordinates between Cartesian and Polar.

Click one of these buttons to rotate the view 45 degrees to the left or to the
right.

Check this box to flip the view.

If Errors are detected, the monitoring function displays a popup window
with all the detected errors. The device will switch into a Lock status.

To go back to Programming, click on the Programming item or on the white
left-pointing arrow.
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APPENDIX A
ACCESS CONTROL

ASSIGN OR CHANGE PASSWORDS

To assign or change the password, the device must be connected (Online).

1. In the DLSentinel Device Selection, click on Scanner and select Settings > Change
Access Controls.
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ASSIGN OR CHANGE PASSWORDS

2. To change or assign the password or access type, you must enter the current one.
Here the user must enter the DLSentinel password to proceed (default password

“admin”, if not changed).

DAUSENSING

DEMO Setings.

E SUSHEPP.BA 0
192168010

3. Enter the new password twice then choose the password type:
eWrite Only (required only when loading the configuration to the device),
eRead / Write (required when connecting and when loading a configuration to the
device),
eNone (no password required).

DAUSENSING ‘

Working -
SLSHSPPBA EMO Settings P 04
BEMO Settings
SLsmsPpEA co statue Pw: WR
E b )
102158010

cccccc
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ACCESS CONTROL

4. Click OK to proceed.

#Ba = 7
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5. The scanner status will now switch to Off-Duty and restart itself.
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RESET A PASSWORD

RESET A PASSWORD

To reset a password, the device must be connected (Online).

1. Inthe DLSentinel Device Selection window, click on Scanner and select Settings >
Reset Password.

i m

[ Open coniguration fom scamer >

g cer
B s . asusenon o PP, g
& seunss O ————
. s @ pmws 2o
18 v e Cranga s conro
T oo oplacemant S 3
B cetmosioversions Facry

T . SIox
T DAUASENSING
sususonon DEMO Setngs W OHIN00ST LSS PP.0A PROFWETROFIsfe 9
e
u sLsusom.en ‘2 sun PwwR 2168010
192163010 S

3. Contact our Technical Support and send the serial and the magic number shown.
A new password will be communicated to the User.

aAtfsensmb

Oiscovery
Vo
Working =
suswsrpan DEMO Setings  FW:OLO0I0ST  SLSMPP.DAPROFNETPROFIste Q
DEMO Settngs
Eslsuw-m o s @ mww e
12188010

Serial normber; "C24PDO01 S

Q Magic number: 0
Passwort

o cancat

NOT CONNECTED.
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APPENDIX B
FIRMWARE UPDATE

To update the firmware, proceed as follows:
1. Start the DLSentinel GUI and select the new configuration task.
2. Enter the Discovery mode and select an online device.

3. Once the device is selected, click Scanner on the menu and choose the firmware
update option.

4. Enter the device password (default password “admin”, if not changed) to access
the firmware update option.

# B DAUASENSING

5. In the Firmware update section (Package section), click on ZIP Archive to search
and select a previously downloaded new firmware version (from the Datasensing
website).

6. Once the new firmware version is selected, click on Load (Configuration Upload).
During the Firmware Update the device will go offline.

—

E |:] Firmware uploading...40%
e
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CHECKS AFTER FIRMWARE UPDATE

When the firmware version is completely loaded, the user enters the Offline-Test
mode to create a configuration and test the new firmware version according to
the procedure released with the new firmware and validate it on field following
the procedure described in "Checks after Firmware Update" on page 57.

If the firmware version is compatible with the device (i.e. the device configuration
is correct and with no failures) click on Accept, otherwise click on Reject (Valida-
tion).

CHECKS AFTER FIRMWARE UPDATE

As with any configuration change, safety checks are also required after firmware update
and device commissioning as well as before normal duty on field. The safety checks
must be carried out by qualified personnel in charge of the machine safety or safety
maintenance in general.

The minimum checks are listed below:

DATASENSING

To test the detection capability of the device(s), the user can use a suitable test
piece, e.g. an optically dark, opaque cylinder. The effective diameter should match
the configured resolution. Datasensing suggests adopting the following proce-
dure:

Place the test piece on several points at the edges of the safety area.

Place the test piece on several points inside the area, radially from the edges to
the center of the laser scanner.

The safety laser scanner must detect the test piece at each position and go to
STOP.

Remove the test piece from the controlled area and check that:

-the machine automatically restarts (in case of Automatic restart), OR

-the machine restarts only after receiving the restart command (in case of Manual
restart).

The following pictures are examples of detection capability test (the red areas cor-

respond to the configured Safety Areas).

Power off the safety laser scanner(s). Check that safety outputs automatically
switch to OFF status and make sure that the machine cannot start until power is
re-applied.

Together with the mentioned checks, it is recommended to perform a visual check
of general functioning using the monitoring tool provided in the Graphic User
Interface of the laser scanner.

Check if the Laser Sentinel shows the interruption of the safety field through the
LEDs and/or display.

It is recommended to follow the same testing approach of detection capability
mentioned before also for different safety areas, checking if the device reaction is
as expected.
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FIRMWARE UPDATE

e Evaluate other specific tests to carry out based on the safety risk analysis of your
own application.

e |Ifinthe end the check reveals a fault or an unexpected behavior, the machine
must be shut down immediately. Try to update the software and test the device
again following the aforementioned procedure. If the problem persists, contact
our Technical Support.
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APPENDIX C
FACTORY RESET

The Factory Reset procedure resets the default password (“admin”), the password type
(see Appendix A, Access Control), the device IP address and any saved configuration.

To perform a Factory Reset, proceed as follows:

1. In the DLSentinel Device Selection, click on Scanner and select Settings > Factory
Reset.

2. A new window will prompt the user to enter the device password (default pass-
word “admin”, if not changed).

3. A new window allows the user to select and execute the reset for:

e GUI Configuration (default, always selected): the configuration saved in the device
is reset.

e Software: the software is restored to the original delivery state.

Fil Scanner  Options

# B2 W DAUSENSING
B

Factory Reset

@  GuIConfiguration
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FACTORY RESET

4. A message will appear informing the user that the operation will take a few min-
utes. Subsequently, the device will be restarted. Click OK to proceed.

DAUASENSING

WARNING

5. At completion, the Getting Started page will appear, and the device will show a
“Waiting Configuration” message (see icon below).

WAITING CONF
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APPENDIX D
ADVANCED MONITORING

The Advanced Monitoring function is available for the following Laser Sentinel models:
e SLS-M5-PP-BA
e SLS-M5-PP-BO

Activating the Advanced Monitoring function makes it possible to receive measurement
distance data and information about the status of the SLS.

To access this function, go to Options > Advanced Monitoring and the following win-
dow is displayed.

Generate Advanced Monitoring Messages
Device selection

SLS-FBUS
Data
Angle Start 0
Angle End 275

Angular Resolution 0.2 degree v

Special Data ENABLED ~

Special Data
Diagnostic Data ENABLED v

Intensity Data ENABLED v
Point on Safety DISABLED v
Active Zone Set DISABLED v

/0 Pin DISABLED v

Network

Local IP . - . Port

| 553 %

Generate advanced monitoring START and STOP message

Generate Cancel

For the device to be monitored, indicate the angle start and end as well as the angular
resolution, enable any special data among the available parameters, then enter the
local IP and the port of the device to generate the START and STOP messages.

For more information, refer to the Laser Sentinel Advanced Monitoring document.
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ADVANCED MONITORING

NOTES
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